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Santéon 

KDP ECMS OVERVIEW  
The eCMS Desktop application provides staff access to review and handle 
documents that are part of an automated workflow business process.  While 
much of the business process runs automatically, some types of errors and 
issues need to be reviewed by staff.  Documents that need staff review and 
action are placed in a queue for staff to access and process.  Using the eCMS 
application, staff can: 

 Review and modify documents 

 View, Add or perform action such as Approve error codes 

 View , Add, Edit or Delete notes 

 View an audit trail of the claim detailing its path in the workflow 

 Make decisions in real time such as Accepting or Rejecting a claim 

 Pend a message in user’s inbox 

 Forward claim(s) to another user or all users 

 Set the claim(s) priority as high, normal or low 

 Users have the option to activate/deactivate the ability to add a comment 
while performing any of the following actions: (Pend, Forward, or Submit) a 
claim 
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eCMS REVIEW COMPONENTS  

Each type of eCMS review has a specific purpose for review of either HCFA-
1500 or UB-92 forms.  Each eCMS user has access to view and use only the 
types of reviews relevant to his/her role.   

 

 

 

 

 

 

 

 

 

 

 Manual Pricing⎯ Review all the claims that have errors in pricing that 
automatic adjudication failed to solve. It also reviews the claims that have 
errors in insurance information. 

 Rejected Claims⎯ Review auto-rejected claims to generate rejection notices 
and print them. 

 Review Claims⎯ Review all the claims with errors, or issues that do not 
conform to the business rules below. This feature reviews all claims that 
violate the following rules: 

Statute of Limitations⎯ Review claims that have a service date outside 
the statute of limitations.   

Diagnosis Codes Check⎯Review claims that have invalid diagnosis 
codes. 

Provider Check⎯ Review claims that have invalid provider data. 

Patient Check⎯ Review claims that have invalid patient name code. 

COB Balancing Check⎯ Review EDI claims that have invalid COB 
balancing. 
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MANUAL PRICING 

PURPOSE 

Review all the claims that have errors in pricing that automatic adjudication failed 
to solve. It also reviews claims that have errors in insurance information. 

 

 STEPS 

1. In the Inbox, click the Manual Pricing eCMS node for either HCFA or UB92 
to display claims in the Message List. 

2. Double click a message in the Message List, or select a message and click 
the  "View Message" button from the toolbar, to display the form in the 
Message Panel. 

3. View the  Notes,  Errors and  Audit Panel as necessary to 
understand any issues and previous actions on this claim. 

4. Select "Adjudication KDP" tab to manually price the claim.   
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5. Enter the Manual Price on the fields in the Manual Charges column (If it is 
blank or if you want to modify the value entered in it).  Then click the 
“Calculate” button to determine the "Total Amount" to pay for this claim.  

 Acceptable Flag Symbols (S*): "Y" means that the service line is 
acceptable. "E" means that the service line is an exact duplicate.  "R" 
means that the service line is rejected. Fields that contain “Y” will be 
added to the total amount to pay otherwise their amount will not be 
calculated. 

 Manual Price: The default price is the smaller of the Calculated Charges 
and the Billed Charges, but you should enter the price manually when any 
of the following errors occurs: 

- MA Rate is zero in the database. 

- Modifier Percentage Price is equal to zero or doesn’t exist in the 
database. 

 Total Calculated Charges: This is the sum of all Service Lines of the 
Calculated Price for each line, excluding rejected or duplicate Service 
lines. 

6. Select an action for the claim.  (Steps to complete each action are described 
below): 

 Pend 

 Submit by accepting or rejecting the claim. 

 Forward to others 
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Pend 
Pending a claim saves the claim for you to review later. 

a. Add any  notes to the claim that may be helpful to you. 

b. Select  “Pend” from the Actions Panel. 

c. If you selected from the View-> Options menu to be prompted for a comment 
a pending reason window will be displayed where you type your comment. 

d. Click  "Close" from the Actions Panel to close the claim. 

Result:  The claim will appear in the Message List in blue with a tool tip 
displaying the pending reason.  At this point, the eCMS Desktop is ready for your 
next action. 

Submit (Accept) 
Overriding an error forwards the claim on towards payment.  If the claim has 
other errors, it may be stopped along the path towards payment more than once.  

a. Add any  notes to the claim that may be helpful to others. (Optional) 

b. Click the "Errors Tab" in the Errors Panel. 

c. Double Click the error in the Errors Panel where the “Error Details wizard” will 
be displayed. 

d. Select "Approved" status from the Status drop down list in the “Errors Details” 
wizard. 
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Note: Select "Approved" for every error in the message or the message will not 
go to the adjudication pathway. 

a. Click “OK” to return to the Actions Panel. 

b. Select “Accept” from the Actions Panel. 

c. Click  “Submit” to forward the claim on towards payment. 

d. Click  "Close" from the Actions Panel to close the claim. 

Result:  eCMS System moves the claim along the adjudication pathway.  At this 
point, Inbox messages are refreshed and the eCMS Desktop is ready for your 
next action. 
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Submit (Reject) 
Rejecting the claim due to an error will immediately remove the claim from the 
adjudication pathway.  This claim will be sent along the rejection pathway, 
possibly meeting rules, automated processes and other users along the way. 

a. Add any  notes to the claim that may be helpful to others. (Optional) 

b. Select “Reject” from the Actions Panel. 

c. Click  “Submit” to forward the claim along the rejection pathway. 

d. Click  "Close" from the Actions Panel to close the message.  

Result:  The claim will disappear from view as the eCMS System moves it along 
the rejection pathway.  At this point, the eCMS Desktop is ready for your next 
action. 

Forward to Others 
You can send a claim to others for review and input. 

a. Add any  notes to the claim that may be helpful to others. (Optional) 

b. Select a user to send the claim to from the  “Forward” dropdown list.  You 
may select a specific person or send it to all users. 

c. Click  "Close" from the Actions Panel to close the message. 

Result:  eCMS system moves the claim to other users. At this point the eCMS 
Desktop is ready for your next action. 
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REJECTED CLAIM  

PURPOSE 

Review auto-rejected claims to generate rejection notices and print them. In this 
review, it is important to review the errors and notes that may give more details 
and a description of the errors regarding the claim.  

 

STEPS 

1. In the Inbox, click the Rejected Claim eCMS node for either HCFA or UB92 
to display claims in the Message List.  

2. Double click a message in the Message List, or select a message and click 
 “View message” button in the toolbar to display the relevant form in the 

Message Panel. 

3. Review the Error Details in the  Errors Panel to understand the reasons 
for rejection.  
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4. View the  Notes Panel as necessary to understand any issues and 
previous actions on this claim that may need to be explained in the rejection 
notice. 

5. Select the "Rejection KDP" tab to review and modify the rejection notices 
form in the Message Panel. 

 

Santéon 
Rejection Notice Form
 

 Check/Uncheck any rejection reasons: Review or change the reasons for 
rejecting the claim by checking or unchecking the checkboxes for each 
rejection reason.  

 Add or modify the provider address: Click "Provider Address" field in the 
rejection notice form and "Provider Address" window will be displayed to 
enter the provider address. 

 Add additional information, if necessary, explaining the reasons for 
rejecting a claim. Click the "Other" field in the rejection notice form and the 
"Other Reason(s)" window displays where you can enter additional 
information about why a claim is rejected. 

 Print the rejection notice form:  Select the "Print" item from the File menu.  
Keep the default settings of “Fit Each Tab to Single Page.” 
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6. Select an action for the claim.  (Steps to complete each action are described 
below): 

 Pend 

 Submit  (Reject) 

 Forward to others 

Pend 
Pending a claim saves the claim for you to review later. 

a. Add any  notes to the claim that may be helpful to you. (Optional) 

b. Select  “Pend” from the Actions Panel. 

c. If you selected from the View-> Options menu to be prompted for a comment 
a pending reason window will be displayed where you type your comment. 

d. Click  "Close" from the Actions Panel to close the claim.  

Result:  The claim will appear in the Message List in blue with a tool tip on the 
pending reason.  At this point, the eCMS Desktop is ready for your next action. 

Submit (Reject) 
Rejecting a claim removes it from the adjudication pathway.  The rejected claim 
is sent to a different Inbox to print a rejection notice. 

a. Add any  notes to the claim that may be helpful to others. (Optional) 

b. Select “Reject” from the “Submit” drop down list.  

c. Click  “Submit” to forward the claim along the rejection pathway. 

d. Click  "Close" from the Actions Panel to close the claim. 

Result:  The claim will disappear from view as the eCMS System moves it along 
the rejection pathway.  At this point, the eCMS Desktop is ready for your next 
action. 
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Forward to Others 
You can send a claim to others for review. 

a. Add any  notes to the claim that may be helpful to others. (Optional) 

b. Select a user to send the claim to from the  “Forward” dropdown list.  You 
may select a specific person or forward it to all users. 

c. Click  "Close" from the Actions Panel to close the claim. 

Result:  eCMS system moves the claim to other users. At this point the eCMS 
Desktop is ready for your next action. 
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REVIEW CLAIM 

PURPOSE 

Review all the claims with errors, or issues that do not conform to the business 
rules below.  It is possible to override the errors with invalid SOL (Statue of 
Limitations), but errors in patient or provider data cannot be overridden. 

 Statute of Limitations⎯ Review claims that have a service date outside 
the statute of limitations.   

 Provider Check⎯ Review the provider data and check if this provider is 
registered with the KDP program. The provider check, checks the "vendor 
number " which consists of the combination of the Federal Tax ID number 
and Service Type on KDP Vendor file and the Store Number if  exists. 

 Patient Check⎯ Review the patient data and check if the patient is 
registered with the KDP program. This program checks the Patient Last 
Name field: First and second character of the last name.  

 COB Balancing Check⎯ Review EDI claims that have invalid COB 
balancing. 

 

 

Santéon 14 



eCMS Client ⎯ KDP 

STEPS 

1. In the Inbox, select Review Claim for either HCFA or UB92 to display claim 
in the Message List. 

2. Double click a message in the Message List, or select a message and click 
 "View message" button in the toolbar to display the form in the Message 

Panel. 

3. View the Error Details in the  Errors Panel to determine if the error is 
acceptable or an issue requiring claim rejection.  
If the error is acceptable and does not prevent the acceptance of a claim, 
change the Error Status field to “Approved.”  

Note: You should select "Approved" for every error in the message for 
adjudication.  In the case of Patient or Provider Check, “Approved” will not 
bypass the error.  In those cases the error should be resolved by changing 
provider or patient file.  “Approved” will recheck for the error.    

Note:  In order for a claim to be accepted, every error must be individually 
overridden by changing each error’s status to “Approved.” 

4. View the  Notes and  Audit Panel as necessary to understand any 
issues and previous actions on this claim. 

5. Select an action for the claim. (Steps to complete each action are described 
below): 

 Pend  

 Submit by accepting or rejecting the claim. 

 Forward to others 
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Pend 
Pending a claim saves the claim for you to review later. 

a. Add any  notes to the claim that may be helpful to you. (Optional) 

b. Select  “Pend” from the Actions Panel. 

c. Click  "Close" from the Actions Panel to close the claim. 

Result:  The claim will appear in the Message List in blue with a tool tip 
displaying the pending reason.  At this point, the eCMS Desktop is ready for your 
next action. 

Submit (Accept) 
Overriding the error forwards the claim on towards payment.  If the claim has 
other errors, it may be stopped along the path towards payment more than once.  

a. Add any  notes to the claim that may be helpful to others. (Optional) 

b. Click the "Errors Tab" in the Errors Panel. 

c. Double click the error in the Errors Panel where the “Error Details” wizard 
will be displayed. 

d. Select "Approved" Status from the Status drop down list in the “Errors 
Details” wizard. 
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e. Click “OK” to return to the Actions Panel. 

f. Select “Accept” from the Actions Panel. 

g. Click  “Submit” to forward the claim on towards payment.  

h. Click  "Close" from the Actions Panel to close the claim. 

Result:  The claim will be submitted directly to the output folder.  At this point, the 
Inbox messages are refreshed and the eCMS Desktop is ready for your next 
action. 

Submit (Reject) 
Rejecting the claim due to an error will immediately remove the claim from the 
adjudication pathway.  This claim will be sent along the rejection pathway, 
possibly meeting rules, automated processes and other users along the way. 

a. Add any  Notes to the claim that may be helpful to others. (Optional) 

b. Select “Reject” from the Actions Panel. 

c. Click  “Submit” to forward the claim along the rejection pathway. 
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d. Click  "Close" from the Actions Panel to close the claim. 

Result:  The claim will move along the rejection pathway.  At this point, the eCMS 
Desktop is ready for your next action. 

Forward to Others 
You can send a claim to others for review. 

a. Add any  notes to the claim that may be helpful to others. (Optional) 

b. Select a user to send the claim to from the  “Forward” dropdown list.  You 
may select a specific person or send it to all users. 

c. Click  "Close" from the Actions Panel to close the claim. 

Result:  eCMS system moves the claim to other users. At this point the eCMS 
Desktop is ready for your next action. 
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